
Founder WordJet C3000

Color Laser Printer
User’s Guide

imagine the possibilities
Thank you for purchasing a Founder product. 



2_Features of your new laser product

features of your new laser product
Your new machine is equipped with a number of special features that improve the quality of the documents you print.
With the machine, you can:

Print with excellent quality and speed
• You can print in a full range of colors using cyan, magenta, 

yellow, and black.
• You can print with a resolution of up to 2400 x 600 dpi 

Effective output.
• Your machine prints A4-sized paper at up to 16 ppm, letter-

sized paper at up to 17 ppm in gray scale mode and 4 ppm 
in color mode.

Handle many different types of printable material
• The 150-sheet tray supports plain paper in various sizes, 

letterhead, envelopes, labels, custom-sized media, 
postcards, and heavy paper. 

Create professional documents
• Print watermarks. You can customize your documents with 

words, such as “Confidential”. See Software section.
• Print posters. The text and pictures of each page of your 

document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster. See 
Software section.

• You can use preprinted forms and letterhead with plain 
paper. See Software section.

Save time and money
• To save paper, you can print multiple pages on one single 

sheet of paper.
• This machine automatically conserves electricity by 

substantially reducing power consumption when not in use.
.

Print in various environments
• You can print with Windows 2000 and Windows XP/2003/

Vista as well as Linux and Macintosh systems.
• Your machine is equipped with a USB interface.

SPECIAL FEATURES
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FEATURES BY MODELS
The machine is designed to support all of your document needs – from printing, to more advanced networking solutions for your business.
Basic features of this machine include;

( : Included, O: Optional, Blank: Not Available) 

ABOUT THIS USER’S GUIDE
This user’s guide provides information about basic understanding of the machine as well as detailed explanation on each step during the actual usage. Both novice 
users and professional users can refer to this guide for installing and using the machine.
Some terms in this guide are used interchangeably, as below:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
Following table offers the conventions of this guide:

FEATURES C3000
USB 2.0

Duplex (2-sided) printing (Manual)

CONVENTION DESCRIPTION EXAMPLE

Bold Used for texts on the display or actual prints on the machine. Start

Note Used to provide additional information or detailed specification of the machine 
function and feature.

The date format may differ from 
country to country

Caution Used to give users information to protect the machine from possible mechanical 
damage or malfunction.

Do not touch the green underside of 
the toner cartridge.

Footnote Used to provide more detailed information on certain words or a phrase. a. pages per minute

(See page 1 for more 
information)

Used to guide users to the reference page for the additional detailed information. (See page 1 for more information)
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FINDING MORE INFORMATION
You can find information for setting up and using your machine from the following resources, either as a print-out or onscreen.

Quick Install Guide Provides information on setting up your machine and this requires that you follow the instructions in the guide to prepare the machine.

Online User’s Guide Provides you with step-by-step instructions for using your machine’s full features, and contains information for maintaining your 
machine, troubleshooting, and installing accessories. 
This user’s guide also contains a Software section to provide you with information on how to print documents with your machine in 
various operating systems, and how to use the included software utilities.

Note 
You can access the user’s guide in other languages from the Manual folder on the printer software CD.

Printer Driver Help Provides you with help information on printer driver properties and instructions for setting up the properties for printing. To access a 
printer driver help screen, click Help from the printer properties dialog box.

Founder website If you have Internet access, you can get help, support, printer drivers, manuals, and order information from the Founder website, http:/
/www.foundertech.com/service/index.htm.

http://www.foundertech.com/service/index.htm
http://www.foundertech.com/service/index.htm
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safety information
IMPORTANT SAFETY SYMBOLS AND PRECAUTIONS

What the icons and signs in this user’s guide mean:

These warning signs are here to prevent injury to you and others. Follow them explicitly. After reading this section, keep it in a safe 
place for future reference.

WARNING

Hazards or unsafe practices that may result in severe personal injury or death.

CAUTION

Hazards or unsafe practices that may result in minor personal injury or property damage.

CAUTION

To reduce the risk of fire, explosion, electric shock, or personal injury when using your laser MFP, follow these basic safety 
precautions:

Do NOT attempt.

Do NOT disassemble.

Do NOT touch.

Follow directions explicitly.

Unplug the power plug from the wall socket.

Make sure the MFP is grounded to prevent electric shock.

Call the service center for help.

1. Read and understand all instructions.
2. Use common sense whenever operating electrical appliances.
3. Follow all warnings and instructions marked on the machine and in the literature accompanying the machine.

4. If an operating instruction appears to conflict with safety information, heed the safety information. You may have misunderstood the 
operating instruction. If you cannot resolve the conflict, contact your sales or service representative for assistance.

5. Unplug the machine from the AC wall socket and/or telephone jack before cleaning. Do not use liquid or aerosol cleaners. Use only 
a damp cloth for cleaning.

6. Do not place the machine on an unstable cart, stand or table. It may fall, causing serious damage.
7. Your machine should never be placed on, near or over a radiator, heater, air conditioner or ventilation duct.
8. Do not allow anything to rest on the power. Do not locate your machine where the cords will be abused by persons walking on them.

9. Do not overload wall outlets and extension cords. This can diminish performance, and may result in the risk of fire or electric shock.
10. Do not allow pets to chew on the AC power, telephone or PC interface cords.
11. Never push objects of any kind into the machine through case or cabinet openings. They may touch dangerous voltage points, 

creating a risk of fire or shock. Never spill liquid of any kind onto or into the machine.

12. To reduce the risk of electric shock, do not disassemble the machine. Take it to a qualified service technician when repair work is 
required. Opening or removing covers may expose you to dangerous voltages or other risks. Incorrect reassembly could cause 
electric shock when the unit is subsequently used.
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LASER SAFETY STATEMENT
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.

WARNING 
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

13. Unplug the machine from the telephone jack, PC and AC wall outlet and refer servicing to qualified service personnel under the 
following conditions:
• When any part of the power cord, plug or connecting cable is damaged or frayed.
• If liquid has been spilled into the machine. 
• If the machine has been exposed to rain or water.
• If the machine does not operate properly after instructions have been followed.
• If the machine has been dropped, or the cabinet appears damaged.
• If the machine exhibits a sudden and distinct change in performance.

14. Adjust only those controls covered by the operating instructions. Improper adjustment of other controls may result in damage, and 
may require extensive work by a qualified service technician to restore the machine to normal operation.

15. Avoid using this machine during a lightning storm. There may be a remote risk of electric shock from lightning. If possible, unplug the 
AC power and telephone cord for the duration of the lightning storm.

16. The Power cord supplied with your machine should be used for safe operation. If you are using a cord which is longer than 2 m with 
110 V machine, then it should be 16 AWGa or bigger.

17. Use only No.26 AWG or larger telephone line cord.

18. SAVE THESE INSTRUCTIONS

a. AWG: American Wire Gauge
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OZONE SAFETY
During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is 
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, request your nearest Founder dealer.

POWER SAVER
This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered. 

RECYCLING
Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

RADIO FREQUENCY EMISSIONS
Operation is subject to the following two conditions: 

• This device may not cause harmful interference, and 
• This device must accept any interference received, including interference that may cause undesired operation.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to oper-
ate the equipment.
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introduction
These are the main components of your machine:

This chapter includes:
• Printer overview
• Control panel overview
• Understanding the control panel

• Supplied software
• Printer driver features

PRINTER OVERVIEW
Front view Rear view

1 Top cover

2 Output tray (face down)

3 Control panel

4 Tray

5 Output support

6 Front cover release button

7 Front cover

8 Toner cartridge

9 Waste toner container
‘

10 Imaging unit

1 Rear cover release button

2 Power switch

3 USB port

4 Power receptacle

5 Rear cover
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CONTROL PANEL OVERVIEW

1 status LED Shows the status of your machine. (See "Understanding the control panel" on page 12 for more information.)

2 stop Stops an operation at any time and there are more functions. (See "Understanding the control panel" on page 12 for more information.)

3 toner colors Show the status of each toner cartridge. See Status LED with the toner cartridge messages on page 12.
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UNDERSTANDING THE CONTROL PANEL
The color of the status and toner colors LED indicates the machine's current 
status.

LEDs

Stop button

STATUSD LED TONER COLORS LED DESCRIPTION

lights green all LEDs off The machine is ready to print.

slowly blinks green all LEDs off The machine is receiving data from the computer.

fast blinks green all LEDs off The machine is printing data.

lights red all LEDs off • The machine is experiencing an error, such as open cover, empty paper, not installed waste 
toner container, or full waste toner container.

• The machine is experiencing a service required error, such as LSU error, fuser error, or ITB 
error, Contact your sales or service representative.

lights orange all LEDs off • The machine is experiencing an error such as jammed paper.
• While the machine is booting up, do not open a top cover, since the machine may treat it as an 

error such as paper jam. In this case, open a front cover and close it then, the machine will 
reboot up.

lights green each LED blinks red Each toner cartridge is near the end of its life.

blinks red each LED lights red Small amount of toner is left in the cartridge. The estimated cartridge lifea of toner is close. Prepare 
a new cartridge for replacement. You may temporarily increase the printing quality by redistributing 
the toner. (See "Redistributing toner" on page 25.)

lights red each LED lights red A toner cartidge has almost reached its estimated cartridge lifea. It is recommended to replace the 
toner cartridge. (See "Replacing the toner cartridge" on page 26.)

lights green each LED blinks red in a 
repeated order

The machine is warming up.

a.Estimated lifespan means the expected or estimated print cartridge life, which indicates the average capacity of print-outs and is designed pursuant to ISO/
OEC 19752. (See "Specifications" on page 40.) The number of pages may be affected by operating environment, printing interval, media type, and media size. 
And some amount of torner may remain in the cartridge even when the printer stops printing.

All printing errors will be appear in the Status Monitor program 
window.

STATUS LED DESCRIPTION

Printing demo page In Ready mode, press and hold this button for about 2 seconds until the status LED blinks slowly, and release.

Printing configuration sheets In Ready mode, press and hold this button for about 5 seconds until the status LED blinks fast, and release.

Canceling print job Press this button during printing. The red LED blinks while the print job is cleared from both the machine and the 
computer, and then the machine returns to ready mode. This may take some time depending on the size of the print job.
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SUPPLIED SOFTWARE
You must install the printer software using the supplied CD after you have 
set up your machine and connected it to your computer. CD provides you 
with the following software.

PRINTER DRIVER FEATURES
Your printer drivers support the following standard features:
• Paper orientation, size, source and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers:

Printer driver
 

CD CONTENTS

Printer 
software CD

Windows • Printer driver: Use this driver to take full 
advantage of your printer’s features.

• Status Monitor: This program allows 
you to monitor the machine’s status and 
alerts you when an error occurs during 
printing.

Linux • Unified Linux Driver: Use this driver 
to take full advantage of your 
machine’s features.

Macintosh • Printer driver: Use this driver to run 
your machine from a Macintosh 
computer and print documents.

• Status Monitor: This program allows 
you to monitor the machine’s status 
and alerts you when an error occurs 
during printing.

Some models or operating system may not support the certain 
feature(s) in the following table.

FEATURE WINDOWS LINUX MACINTOSH

Color mode O O O

Machine quality option O O O

Poster printing O X X

Multiple pages per sheet 
(N-up)

O O (2, 4) O

Fit to page printing O X O

Scale printing O X O

Watermark O X X

Overlay O X X

Duplex (Manual) O X X
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getting started
This chapter gives you step-by-step instructions for setting up the machine.

This chapter includes:
• Setting up the hardware
• Printing a demo page

• System requirements
• Machine's basic settings

SETTING UP THE HARDWARE
This section shows the steps to set up the hardware which is explained in 
the Quick Install Guide. Make sure you read Quick Install Guide and 
complete following steps.
1. Select a stable location. 

Select a level, stable place with adequate space for air circulation. Allow 
extra space to open covers and trays. 
The area should be well-ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to the 
edge of your desk or table.

 

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to the 
altitude setting to optimize your printing. See "Altitude adjustment" on 
page 15 for more information.
Place the machine on a flat and stable surface, not letting it lean more 
than 2 mm (0.08 inches). Otherwise, it may affect the printing quality. 

2. Unpack the machine and check all the enclosed items.
3. Remove the tape holding the machine tightly.
4. Load paper. (See "Changing the size of the paper in the paper tray" on 

page 19.)
5. Make sure that all the cables are connected to the machine. 

6. Turn the machine on. 

PRINTING A DEMO PAGE
Print a demo page to make sure that the machine is operating correctly.
To print a demo page:
In ready mode, press and hold the Stop button for about 2 seconds.

SYSTEM REQUIREMENTS
Before you begin, ensure that your system meets the following 
requirements:

Windows
Your machine supports the following Windows operating systems.

• When you move the machine, do not tilt or turn it upside down. 
Otherwise, the inside of the machine may be contaminated by 
toner, which can cause damage to the machine or bad print 
quality.

• This equipment will be inoperable when mains power fails.

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM FREE HDD 
SPACE

Windows 
2000

Pentium II 400 MHz 
(Pentium III 933 MHz)

128 MB 
(256 MB)

600 MB

Windows XP Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB 
(256 MB)

1.5 GB

Windows 
Server 2003 

Pentium III 933 MHz 
(Pentium IV 1 GHz)

128 MB 
(512 MB)

1.25 GB to 
2 GB

Windows 
Vista

Pentium IV 3 GHz 512 MB 
(1024 MB)

15 GB

Windows 
Server 2008

Pentium IV 1 GHz 
(Pentium IV 2 GHz)

512 MB 
(2048 MB)

10 GB

• Internet Explorer 6.0 or higher is the minimum requirement for all 
Windows operating systems.

• Users who have an administrator right can install the software.
• Windows Terminal Services is compatable with this machine.
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Macintosh

Linux

MACHINE'S BASIC SETTINGS
After installation is complete, you may want to set the machine's default 
settings. Refer to the next section if you would like to set or change values.

Altitude adjustment
The print quality is affected by atmospheric pressure, which is determined 
by the height of the machine above sea level. The following information will 
guide you on how to set your machine to the best print quality or best quality 
of print.
Before you set the altitude value, find the altitude where you are using the 
machine.

1. Ensure that you have installed the printer driver with the provided     
Printer Software CD.

2. From the Start menu, select Programs or All Programs > your printer 
driver icon > Printer Settings Utility.

3. Click Setting > Altitude Adjustment. Select the appropriate value from 
the dropdown list, and then click Apply. 

Using the save modes
Power Save mode
Power Save mode allows your machine to reduce power consumption 
when it is not in actual use. You can turn this mode on and select a 
length of time for which the machine waits after a job is printed before it 
switches to a reduced power state.
1. Ensure that you have installed the printer driver with the provided     

Printer Software CD.
2. From the Start menu, select Programs or All Programs > your 

printer driver icon > Printer Settings Utility.
3. Click Setting > Power Save. Select the appropriate value from the 

dropdown list, and then click Apply. 

Auto continue
This is the option to set the machine to continue printing or not, in case the 
paper size you have set and the paper within the tray mismatches. 
1. Ensure that you have installed the printer driver with the provided     

Printer Software CD.
2. From the Start menu, select Programs or All Programs > your printer 

driver icon > Printer Settings Utility.
3. Click Setting > Auto Continue. Select the appropriate value from the 

dropdown list, and then click Apply. 

OPERATING 
SYSTEM

REQUIREMENT (RECOMMENDED)

CPU RAM
FREE 
HDD 

SPACE

Mac OS X 
10.3 ~ 10.4

• Intel Processor
• Power PC G4 /

G5

• 128 MB for a 
Power-PC based 
Mac (512 MB).

• 512 MB for an 
Intel-based Mac (1 
GB)

1 GB

Mac OS X 10.5 • Intel Processor
• 867 MHz or 

faster Power 
PC G4 /G5

512 MB (1 GB) 1 GB

ITEM REQUIREMENTS

Operating system RedHat Enterprise Linux WS 4, 5 (32/64bit)
Fedora Core 2~10 (32/64bit)
SuSE Linux 9.1 (32bit)
OpenSuSE 9.2, 9.3, 10.0, 10.1, 10.2, 10.3, 11.0, 
11.1 (32/64bit)
Mandrake 10.0, 10.1 (32/64bit)
Mandriva 2005, 2006, 2007, 2008, 2009 (32/64bit)
Ubuntu 6.06, 6.10, 7.04, 7.10, 8.04, 8.10 (32/64bit)
SuSE Linux Enterprise Desktop 9, 10 (32/64bit)
Debian 3.1, 4.0, 5.0 (32/64bit)

CPU Pentium IV 2.4GHz (IntelCore2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2GB)

1 Normal
2 High 1
3 High 2
4 High 3 

0
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selecting and loading print media
This chapter introduces you how to load originals and print media into your machine.

This chapter includes:
• Selecting print media
• Changing the size of the paper in the paper tray
• Printing on special print materials

• Adjusting the output support
• Setting the paper size and type

SELECTING PRINT MEDIA
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meet the guidelines 
for use with your machine. Print media that does not meet the guidelines 
outlined in this user’s guide may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.
Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described later in this section.
• Desired outcome: The print media you choose should be appropriate for 

your project.
• Brightness: Some print media are whiter than others and produce 

sharper, more vibrant images.
• Surface smoothness: The smoothness of the print media affects how 

crisp the printing looks on the paper.

• Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of 
improper handling, unacceptable temperature and humidity levels, 
or other variables over which Founder has no control.

• Before purchasing large quantities of print media, ensure that it 
meets the requirements specified in this user’s guide. 

Using print media that does not meet these specifications may cause 
problems, requiring repairs. Such repairs are not covered by 
Founder’s warranty or service agreements.

Make sure not to use the inkjet photo paper with this machine. It could 
cause damage to the machine. 
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Specifications on print media

TYPE SIZE DIMENSIONS WEIGHTA CAPACITYB

Plain paper Letter 216 x 279 mm (8.5 x 11 inches) • 60 to 105 g/m2 (16 to 28 lb bond)

• 60 to 163 g/m2 (16 to 43 lb bond) 

• 150 sheets of 75 g/m2 

(20 lb bond) paper for the 
tray

• 1 sheet for manual feeding 
in the tray

Legal 216 x 356 mm (8.5 x 14 inches)

Folio 216 x 330 mm (8.5 x 13 inches)

A4 210 x 297 mm (8.26 x 11.69 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

JIS B5 182 x 257 mm (7.16 x 10.11 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.5 inches)

Statement 140 x 216 mm (5.50 x 8.50 inches)

A5 148 x 210 mm (5.82 x 8.26 inches)

A6 105 x 148 mm (4.13 x 5.82 inches)

Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches) 75 to 90 g/m2 (20 to 24 lb bond) 5 sheets for manual feeding 
in the tray

No. 10 105 x 241 mm (4.12 x 9.5 inches)

DL 110 x 220 mm (4.33 x 8.66 inches)

C5 162 x 229 mm (6.37 x 9.01 inches)

C6 114 x 162 mm (4.48 x 6.38 inches)

No.9 98 x 225 mm (3.87 x 8.87 inches)

6 3/4 92 x 165 mm (3.62 x 6.5 inches)

Thick paper Refer to the Plain 
paper section

Refer to the Plain paper section 90 to 105 g/m2 (24 to 28 lb bond)

Thin paper Refer to the Plain 
paper section

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lb bond)

Labelsc Letter, A4 Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lb bond)

Card stock Post card 101.6 x 152.4 mm (4 x 6 inches) 105 to 163 g/m2 (28 to 43 lb bond)

Transparencyd Letter, A4 Refer to the Plain paper section 138 to 146 g/m2 (37 to 39 lb bond) 1 sheet for manual feeding in 
the tray

Glossy paper Lettere, A4f Refer to the Plain paper section 160 g/m2 (44 lb bond)

Minimum size (custom) 76 x 160 mm (3 x 6.3 inches) 60 to 163 g/m2 (16 to 43 lb bond) 

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)

a. If media weight is over 105 g/m2 (28 lb bond), load a paper into the tray one by one.
b.Maximum capacity may differ depending on media weight, thickness, and environmental conditions.
c. Smoothness: 100 to 250 (sheffield)
d.Recommended media: Transparency for a color laser printer by Xerox such as 3R 91331(A4), 3R 2780(Letter).
e.Recommended media: Glossy paper (Letter) for this machine by HP Brochure Paper (Product: Q6611A) only.
f. Recommended media: Glossy paper (A4) for this machine by HP Superior Paper 160 glossy (Product: Q6616A) only.
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Guidelines for special print media

MEDIA TYPE GUIDELINES

Envelopes • Successful printing on envelopes depends upon the 
quality of the envelopes. When selecting envelopes, 
consider the following factors:
- Weight: The weight of the envelope paper should 

not exceed 90 g/m2 or jamming may occur.
- Construction: Prior to printing, envelopes should 

lie flat with less than 6 mm curl, and should not 
contain air.

- Condition: Envelopes should not be wrinkled, 
nicked, or otherwise damaged.

- Temperature: You should use envelopes that are 
compatible with the heat and pressure of the 
machine during operation.

• Use only well-constructed envelopes with sharp and 
well creased folds.

• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, 

coated lining, self-adhesive seals, or other synthetic 
materials.

• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope 

extends all the way to the corner of the envelope.

1 Acceptable
2 Unacceptable

• Envelopes with a peel-off adhesive strip or with 
more than one flap that folds over to seal must use 
adhesives compatible with the machine’s fusing 
temperature for 0.1 second. Check your machine’s 
specification to view the fusing temperature, see 
page 40. The extra flaps and strips might cause 
wrinkling, creasing, or jams, and may even damage 
the fuser.

• For the best print quality, position margins no closer 
than 15 mm from the edges of the envelope.

• Avoid printing over the area where the envelope’s 
seams meet.

Labels • To avoid damaging the machine, use only labels 
designed for use in laser machines.
- When selecting labels, consider the following 

factors:
- Adhesives: The adhesive material should be 

stable at your machine’s fusing temperature. 
Check your machine’s specification to view the 
fusing temperature, see page 40.

- Arrangement: Only use labels with no exposed 
backing between them. Labels can peel off sheets 
that have spaces between the labels, causing 
serious jams.

- Curl: Prior to printing, labels must lie flat with no 
more than 13 mm of curl in any direction.

- Condition: Do not use labels with wrinkles, 
bubbles, or other indications of separation.

• Make sure that there is no exposed adhesive 
material between labels. Exposed areas can cause 
labels to peel off during printing, which can cause 
paper jams. Exposed adhesive can also cause 
damage to machine components.

• Do not run a sheet of labels through the machine 
more than once. The adhesive backing is designed 
for only a single pass through the machine.

• Do not use labels that are separating from the 
backing sheet or are wrinkled, bubbled, or otherwise 
damaged.

Card stock or 
custom-sized 
materials

• Do not print on media smaller than 76 mm wide or 
356 mm long.

• In the software application, set margins at least 
6.4 mm away from the edges of the material.

Preprinted 
paper

• Letterhead must be printed with heat-resistant ink 
that will not melt, vaporize, or release hazardous 
emissions when subjected to the printer’s fusing 
temperature for 0.1 second. Check your machine’s 
specification to view the fusing temperature, see 
page 40.

• Letterhead ink must be non-flammable and should 
not adversely affect printer rollers.

• Forms and letterhead should be sealed in a 
moisture-proof wrapping to prevent changes during 
storage.

• Before you load preprinted paper, such as forms 
and letterhead, verify that the ink on the paper is 
dry. During the fusing process, wet ink can come off 
preprinted paper, reducing print quality.

Using photographic paper or coated paper may cause problems, 
requiring repairs. Such repairs are not covered by Founder’s warranty 
or service agreements.

MEDIA TYPE GUIDELINES
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CHANGING THE SIZE OF THE PAPER IN THE 
PAPER TRAY
To load different sizes of paper, such as Legal-sized paper, you need to 
adjust the paper guides to extend the paper tray.
To change the tray size to other size, you must adjust the paper length 
guide properly.

1. Pull the tray out of the machine. Open the paper cover and remove 
paper from the tray if necessary. 

2. Pressing and unlatching the guide lock in the top of the tray, pull the tray 
out manually.

3. Load paper into the tray.

4. Slide the paper length guide until it lightly touches the end of the paper 
stack. Squeeze the paper width guide and slide it to the edge of the 
paper stack without causing it to bend.

For paper smaller than Letter-sized, return the paper guides to their 
original positions and adjust the paper length guide and paper width 
guide.

If the paper that you need to print is shorter than length 222 mm (8.74 
inches), press and unlatch the guide lock in the tray, push the tray in 
manually. Adjust the paper length guide and paper width guide.        

   

1 Tray extend lever
2 Paper length guide
3 Paper width guide
4 Paper cover

• Do not push the paper width guides far enough to cause the 
materials to warp.

• If you do not adjust the paper width guides, it may cause paper 
jams.
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5. Close the paper cover.

6. Slide the tray back into the machine until it clicks.
7. After loading paper, set the paper type and size for the tray. See "Setting 

the paper size and type" on page 21.

The tray is preset to Letter or A4 size, depending on your country. To 
change the size to A4 or Letter, you must adjust the lever and paper width 
guide properly.

1 Pull the tray out of the machine. Open the paper cover and remove 
paper from the tray if necessary.

2 If you want to change the size to Letter, hold the lever at the back of the 
tray, and rotate the lever clockwise.

3 Squeeze the paper width guide and slide it to the edge of the lever.

• If you experience problems with paper feed, place one sheet at a 
time in the tray.

• You can load previously printed paper. The printed side should be 
facing up with an uncurled edge at the rear. If you experience 
problems with paper feed, turn the paper around. Note that print 
quality is not guaranteed. 

If you want to change the size to A4, first move the paper width guide 
to left and rotate the lever counterclockwise. If you force the lever, it 
could damage the tray.
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PRINTING ON SPECIAL PRINT MATERIALS
The machine can hold special sizes and types of print material, such as 
postcards, note cards, and envelopes. Especially, it is useful for single page 
printing on letterhead or colored paper.

Feeding the print material manually
• Load only one size of print media at a time in the tray.
• To prevent paper jams, do not add paper when there is still paper in 

the tray. This also applies to other types of print media.
• Print media should be loaded face up with the side you want to print, 

and the top edge going into the tray first. Place print materials in the 
center of the tray.

• Always load only the specified print media to avoid paper jams and 
print quality problems. (See "Selecting print media" on page 16.)

• Flatten any curl on postcards, envelopes, and labels before loading 
them into the tray.

1. Load the paper. (See "Changing the size of the paper in the paper 
tray" on page 19.)

2. When you print in application, start the print menu.
3. Before you print, open printer properties.
4. Press the Paper tab in printer properties, and select an appropriate 

paper type. 

5. Select Manual Feeder in paper source then, press OK. 
6. Start printing in application.

7. Press the Stop button on the machine to start feeding then the 
machine starts printing.

ADJUSTING THE OUTPUT SUPPORT
The printed pages stack on the output tray, and the output support will help 
the printed pages align. To let the output support correctly align the pages 
you need to pull it out appropriately depending on the paper size.

SETTING THE PAPER SIZE AND TYPE
After loading paper in the paper tray, you need to set the paper size and 
type using the printer driver. Follow these steps to make your changes 
permanent.

1. Click the Start button on the computer screen.
2. Select Printers and Faxes.
3. Right-click on the printer driver icon and select Printing Preferences.
4. Click the Paper tab, and change the settings on Paper Options.
5. Click OK.

Depending on the media type you are using, keep the following 
loading guidelines:
• Envelopes: Flap side down and with the stamp area on the 

top left side.
• Labels: Print side up and top short edge entering the machine 

first.
• Preprinted paper: Design side up with the top edge toward the 

machine.
• Card stock: Print side up and the short edge entering the 

machine first.
• Previously printed paper: Previously printed side down with 

an uncurled edge toward the machine.

If you want to use an label, set the paper type to Label. 

• If you are printing multiple pages, load the next sheet after first 
page prints out, and press the Stop button. Repeat this 
step for every page to be printed.

• The settings you change remain in effect only while you are 
using the current application. 

1 Output support

• If the output support is incorrectly adjusted, printed pages may be 
mis-aligned or fall.

• If you continuously print many pages, the surface of the output tray 
may become hot. Be careful not to touch the surface, and 
especially keep children away from the surface.

The following procedure is for Windows XP. For other Windows OS, 
refer to the corresponding Windows User's Guide or online help. 
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basic printing
This chapter explains common printing tasks.

This chapter includes:
• Printing a document • Canceling a print job

PRINTING A DOCUMENT
Your machine allows you to print from various Windows, Macintosh, or 
Linux applications. The exact steps for printing a document may vary 
depending on the application you use.
For details about printing, see the Software secion.

CANCELING A PRINT JOB
If the print job is waiting in a print queue or print spooler, such as the printer 
group in Windows, delete the job as follows:
1. Click the Windows Start menu.
2. For Windows 2000, select Settings and then Printers.

For Windows XP/2003, select Printers and Faxes.
For Windows Vista, select Control Panel > Hardware and Sound > 
Printers.

3. Double-click the Founder WordJet C3000 icon.
4. From the Document menu, select Cancel.

You can also cancel the current job by pressing Stop on the control 
panel.

You can also access this window by simply double-clicking the printer 
icon at the bottom right corner of the Windows desktop.
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maintenance
This chapter provides information for maintaining your machine and the toner cartridge.

This chapter includes:
• Printing reports
• Cleaning your machine
• Maintaining the cartridge
• Replacing the toner cartridge

• Replacing the Imaging Unit
• Replacing the waste toner container
• Maintenance parts

PRINTING REPORTS
You can print a configuration report from the machine’s control panel. Use 
the configuration page to view the current settings, to help troubleshoot 
problems. In Ready mode, press and hold the Stop button on the 
control panel for about 5 seconds.

CLEANING YOUR MACHINE
To maintain print quality, follow the cleaning procedures below each time 
the toner cartridge is replaced or if print quality problems occur.

Cleaning the outside
Clean the cabinet of the machine with a soft lint-free cloth. You can dampen 
the cloth slightly with water, but be careful not to let any water drip onto or 
into the machine.

Cleaning the inside
During the printing process, paper, toner, and dust particles can accumulate 
inside the machine. This buildup can cause print quality problems, such as 
toner specks or smearing. Cleaning the inside of the machine clears or 
reduces these problems.
1. Turn the machine off and unplug the power cord. Wait for the machine to 

cool down.
2. Press the release button, completely open the front cover.

3. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the machine.

4. Pull the waste toner container out of the machine using its handle.
  

• Cleaning the cabinet of the machine with cleaning materials 
containing large amounts of alcohol, solvent, or other strong 
substances can discolor or distort the cabinet.

• If your machine or its surrounding is contaminated with toner, we 
recommend you to use cloth or tissue dampened with water to 
clean it. If you use a vacuum cleaner, toner blown into the air may 
be harmful. 
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5. Pull the imaging unit out of the machine using the groove on the front of 
the imaging unit.

   

6. With a dry lint-free cloth, wipe away any dust and spilled toner from the 
toner cartridges area and their cavities.

7. Holding the groove on the front of the imaging unit, push imaging unit in 
to the machine.

 

8. Insert the waste toner container into position and then push it to make 
sure that it is firmly seated in place.

9. Slide the toner cartridge back into the machine.

10. Reinstall all the compartments into the machine, and close the front 
cover.

11. Plug in the power cord and turn the machine on

• Do not touch the green surface on the imaging unit with your 
hands or any other material. 

• Be careful not to scratch the surface of the imaging unit.
• If you leave the front cover open for more than a few minutes, the 

imaging unit can be exposed to light. This will cause damage to 
the imaging unit. Close the front cover should the installation need 
to be halted for any reason.

• If toner gets on your clothing, wipe it off with a dry cloth and wash 
it in cold water. Hot water sets toner into fabric.

• If your machine or its surrounding is contaminated with toner, we 
recommend you to use a cloth or tissue dampened with water to 
clean it. If you use a vacuum cleaner, toner blows into the air then 
might be harmful to you.

After cleaning, let the machine to dry completely.

If the front cover is not completely closed, the machine will not 
operate.
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MAINTAINING THE CARTRIDGE
Toner cartridge storage
Toner cartridges contain components that are sensitive to light, 
temperature, and humidity. Founder suggests users follow the 
recommendations to ensure the optimum performance, highest quality, and 
longest life from your new Founder toner cartridge.

Store this cartridge in the same environment as the printer it will be used in; 
this should be in controlled office temperature and humidity conditions. The 
toner cartridge should remain in its original, unopened package until 
installation – If original packaging is not available, cover the top opening of 
the cartridge with paper and store in a dark cabinet. 
Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, always store the cartridge:

• Inside the protective bag from the original package 
• Correct side up in a horizontal position (not standing on end)
• Do not store consumables in; 

- Temperature greater than 40°C (104°F). 
- Humidity range less than 20% and not greater than 80%.
- An environment with extreme changes in humidity or temperature.
- Direct sunlight or room light.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

Handling instructions
• Do not touch the surface of the photosensitive drum in the cartridge. 
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.

Use of non-Founder and refilled toner cartridge
Founder does not recommend or approve the use of non-Founder brand 
toner cartridges in your printer including generic, store brand, refilled, or 
remanufactured toner cartridges. 

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print-out number may 
vary depending on the print density of the pages you print on, operating 
environment, printing interval, media type, and/or media size. For example, 
if you print a lot of graphics, the consumption of the toner is high and you 
may need to change the cartridge more often.

Redistributing toner
It is possible that colored images may be printed with incorrect colors due to 
flawed mixing of toner colors when one of the colored toner cartridges is low 
on toner. You can temporarily improve print quality by redistributing the 
toner.
• The Status Monitor program window appears on the computer telling 

you which color cartridge is low on toner.

1. Press the release button, completely open the front cover.

2. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the machine.

3. Holding both handles on the toner cartridge, thoroughly rock it from side 
to side to evenly distribute the toner. 

• Founder’s printer warranty does not cover damage to the machine 
caused by the use of a refilled, remanufactured, or non-Founder 
brand toner cartridge.

If toner gets on your clothing, wipe it off with a dry
cloth and wash it in cold water. Hot water sets toner into
fabric.
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4. Slide the toner cartridge back into the machine.

5. Close the front cover. Make sure the cover is securely latched.

REPLACING THE TONER CARTRIDGE
The machine uses four colors and has a different toner cartridge for each 
one: yellow (Y), magenta (M), cyan (C), and black (K).
A toner cartridge has reached its estimated cartridge life. The printer stops 
printing. Also, the Status Monitor program window appears on the computer 
telling you to replace the cartridge.
At this stage, the toner cartridge needs to be replaced. Check the type of 
toner cartridge for your machine. (See "Supplies" on page 39.) 

1. Turn the machine off, then wait a few minutes for the machine to cool.
2. Press the release button, completely open the front cover.

3. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the machine.

4. Holding both handles on the toner cartridge, thoroughly rock it from side 
to side to evenly distribute the toner.

 

5. Take a new toner cartridge out of its package.

6. Place the toner cartridge on a flat surface, as shown, and remove the 
protecting cover.

If the front cover is not completely closed, the machine will not 
operate.

Founder does not recommend using non-genuine Founder toner 
cartridge such as refilled or remanufactured. Founder cannot 
guarantee non-genuine Founder toner cartridge's quality or 
damages it can cause to the machine. Also  service or repair 
required as a result of using non-genuine Founder toner 
cartridges will not be covered under the machine warranty.

• Don't use sharp objects, such as a knife or scissors, to open 
the toner cartridge package. You could damage the surface of 
the toner cartridge.

• To prevent damage, do not expose the toner cartridge to light 
for more than a few minutes. Cover it with a piece of paper to 
protect it if necessary.

If toner gets on your clothing, wipe it off with a dry cloth and wash 
it in cold water. Hot water sets toner into fabric.
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7. Make sure that the color of the toner cartridge matches the color slot and 
then grasp the handles on the toner cartridge. Insert the cartridge until it 
clicks into place.

8. Close the front cover. Make sure the cover is securely latched, and then 
turn the machine on.

REPLACING THE IMAGING UNIT
When the life span of the imaging unit has expired, the Status Monitor 
program window appears on the computer, indicating the imaging unit 
needs to be replaced. Otherwise your machine stops printing.
1. Turn the machine off, then wait a few minutes for the machine to cool.
2. Press the release button, completely open the front cover.

 

3. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the machine.

4. Pull the waste toner container out of the machine using its handle.

If the front cover is not completely closed, the machine will not 
operate.



28 _Maintenance

5. Pull the imaging unit out of the machine using the groove on the front of 
the imaging unit. 

  

6. Take a new imaging unit out of its package.   
   

7. Holding the groove on the front of the imaging unit, push imaging unit in 
to the machine.

 

8. Insert the waste toner container into position and then push it to make 
sure that it is firmly seated in place.

9. Slide the toner cartridge back into the machine.

10. Close the front cover firmly. 

11. Turn the machine on.

• Don’t use sharp objects, such as a knife or scissors, to open the 
imaging unit package. You could damage the surface of the 
imaging unit.

• Be careful not to scratch the surface of the imaging unit.
• To prevent damage, do not expose the imaging unit to light for 

more than a few minutes. Cover it with a piece of paper to protect 
it if necessary.

If the front cover is not completely closed, the machine will not 
operate. Please make sure all toner cartridges are installed properly. 
If any toner cartridge is installed improperly, the front cover do not 
close.

Each LED blinks red in a repeated order. Wait for about 1.5 minutes 
for your machine to get ready.
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REPLACING THE WASTE TONER CONTAINER
When the life span of the waste toner container has expired, the Status 
Monitor program window appears on the computer, indicating the waste 
toner container needs to be replaced. Otherwise your machine stops 
printing.
1. Turn the machine off, then wait a few minutes for the machine to cool.
2. Open the front cover.

 

3. Pull the waste toner container out of the machine using its handle.

4. Remove the container’s cap from the container as shown below, and 
use it to close the waste toner container opening.

5. Take a new waste toner container out of its package.

6. Insert the new container into position and then push it to make sure that 
it is firmly seated in place.

7. Close the front cover firmly.
 

8. Turn the machine on.Make sure that you lay the waste toner container on a flat surface so 
that the toner does not spill.

Do not tilt or turn over the container. 

If the front cover is not completely closed, the machine will not 
operate. Please make sure all toner cartridges are installed properly. 
If any toner cartridge is installed improperly, the front cover do not 
close.
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MAINTENANCE PARTS
To avoid print quality and paper feed problems resulting from worn parts, 
and to maintain your machine in top working condition the following 
condition, the following items will need to be replaced after the specified 
number of pages, or when the life span of each item has expired. 

 

We highly recommend that this maintenance be performed by an authorized 
service provider, dealer or the retailer where you bought the machine. The 
warranty does not cover the replacement of the maintenance parts after 
their lifespan.

ITEMS YIELD (AVERAGE)

Pick-up roller Approx. 50,000 pages

Fuser unit Approx. 100,000 black pages or 
25,000 color pages

Transfer roller Approx. 100,000 pages

Transfer Unit (ITB) Approx. 100,000 black pages or 
25,000 color pages
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troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

This chapter includes:
• Tips for avoiding paper jams
• Clearing paper jams

• Solving other problems

TIPS FOR AVOIDING PAPER JAMS
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, follow the steps outlined on page 31. 
• Follow the procedures on page 19. Ensure that the adjustable guides 

are positioned correctly.
• Do not overload the tray. Ensure that the paper level is below the paper 

capacity mark on the inside of the tray.
• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media. (See "Setting the paper size and 

type" on page 21.)
• Ensure that the recommended side of the print media is facing up in the 

tray.

CLEARING PAPER JAMS

If a paper jam occurs, the status LED on the control panel lights red. Find 
and remove the jammed paper. 
To resume printing after clearing paper jams, you must open and close the 
front cover or rear cover.
If paper is jammed in the paper feed area, follow the next steps to release 
the jammed paper. 
1. Pull the tray out of the printer and remove the jammed paper.

If you cannot find the jammed paper, go to the next step.

2. To remove the jammed paper, open the rear cover.  

3. Carefully remove the paper by pulling in the direction as shown below. 
Most of the jammed paper can be removed in this step.  

 

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling and go to the next step.

To avoid tearing the paper, pull the jammed paper out gently and 
slowly. Follow the instructions in the following sections to clear the 
jam. 

If the paper tears, make sure that all of the paper fragments are 
removed from the printer.
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4. Push the fuser levers upwards.  

5. Open the top cover and inner cover.  

6. Holding the inner cover open, carefully take the jammed paper out of the 
printer. The inner cover will then close automatically.  

7. Close the top cover. Make sure that it is securely closed. 

8. Push the fuser levers downwards.

9. Open and then close the rear cover or front cover to resume printing.

1 fuser lever

Do not touch the fuser inside the inner cover. It is hot and could cause 
burns! The fuser’s operating temperature is 180 °C (356 °F). Take 
care when removing paper from the printer.
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SOLVING OTHER PROBLEMS
The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, call for service.

Paper feeding 

Printing problems

CONDITION SUGGESTED SOLUTIONS

Paper is jammed 
during printing.

Clear the paper jam. See page 31.

Paper sticks 
together.

• Ensure there is not too much paper in the tray. 
The tray can hold up to 150 sheets of paper, 
depending on the thickness of your paper.

• Make sure that you are using the correct type 
of paper. See page 21.

• Remove paper from the tray and flex or fan the 
paper.

• Humid conditions may cause some paper to 
stick together.

Multiple sheets of 
paper do not feed.

• Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

• If multiple sheets have caused a paper jam, 
clear the paper jam. See page 31.

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine. See page 16.

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, load only one size of print 
media at a time in the tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine. See page 17.

• There may be debris inside the machine. Open 
the front cover and remove the debris.

Envelopes skew or 
fail to feed correctly.

Ensure the paper guides are against both sides of 
the envelopes.

CONDITION POSSIBLE 
CAUSE SUGGESTED SOLUTIONS

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord 
connections. Check the 
power switch and the power 
source.

The machine is not 
selected as the 
default printer.

Select Founder WordJet 
C3000 as your default printer 
in your Windows.

• Check the machine for the following:
• The front cover is not closed. Close the cover.
• Paper is jammed. Clear the paper jam. See page 

31.
• No paper is loaded. Load paper. See page 19.
• The toner cartridge is not installed. Install the 

toner cartridge.
• If a system error occurs, contact your service 

representative.

The connection 
cable between the 
computer and the 
machine is not 
connected properly.

Disconnect the printer cable 
and reconnect it.

The connection 
cable between the 
computer and the 
machine is 
defective.

If possible, attach the cable 
to another computer that is 
working properly and print a 
job. You can also try using a 
different printer cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has 
more than one port, make 
sure that the machine is 
attached to the correct one.

The machine may 
be configured 
incorrectly. 

Check the printer properties 
to ensure that all of the print 
settings are correct. 

The printer driver 
may be incorrectly 
installed.

Repair the printer software. 
See the Software section.

The machine is 
malfunctioning.

Check the LEDs status on 
the control panel to see if the 
machine is indicating a 
system error.

The machine 
does not print 
special sized 
paper such as a 
billing paper.

Paper size and 
paper size setting do 
not match. 

Set the correct paper size in 
the custom in the paper tab in 
the printer properties.
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
you may notice a reduction in print quality. See the table below to clear the 
problem.

The machine 
selects print 
materials from 
the wrong paper 
source.

The paper source 
selection in the 
printer properties 
may be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Thin Paper tab 
within the printer properties. 
Select the correct paper 
source. See the printer driver 
help screen.

A print job is 
extremely slow.

The job may be very 
complex.

Reduce the complexity of the 
page or try adjusting the print 
quality settings.

Half the page is 
blank.

The page orientation 
setting may be 
incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the 
tray.
Or, ensure that the paper 
size in the printer driver 
settings matches the paper 
selection in the software 
application settings you use.

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The printer cable is 
loose or defective.

Disconnect the printer cable 
and reconnect. Try a print job 
that you have already printed 
successfully. If possible, 
attach the cable and the 
machine to another computer 
and try a print job that you 
know works. Finally, try a 
new printer cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine 
off and then back on again.

Pages print, but 
are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary. See page 25.
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such as 
the controller or the 
board, may be 
defective.

Contact a service 
representative.

CONDITION POSSIBLE 
CAUSE SUGGESTED SOLUTIONS

The printer does 
not print PDF file 
correctly. Some 
parts of 
graphics, text, or 
illustrations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products.

Printing the PDF file as an 
image may solve this 
problem. Turn on Print As 
Image from the Acrobat 
printing options.

It will take longer to 
print when you print a 
PDF file as an image.

Your machine 
has an odd smell 
during initial 
use.

The oil used to 
protect the fuser is 
evaporating.

After printing about 100 color 
pages, there will be no more 
smell. It is a temporary issue.

The print quality 
of photos is not 
good. Images 
are not clear.

The resolution of the 
photo is very low. 

Reduce the photo size. If you 
increase the photo size in the 
software application, the 
resolution will be reduced. 

Before printing, 
the machine 
emits vapor near 
the output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

CONDITION SUGGESTED SOLUTIONS

Light or faded print If a vertical white streak or faded area appears 
on the page:
• The toner supply is low. You may be able 

to temporarily extend the toner cartridge 
life. See page 26. If this does not improve 
the print quality, install a new toner 
cartridge.

• The paper may not meet paper 
specifications; for example, the paper is too 
moist or too rough. See page 16.

• If the entire page is light, the print 
resolution setting is too low. Adjust the print 
resolution. See the help screen of the 
printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning.

• The surface of the LSU part inside the 
machine may be dirty. Clean the LSU by 
opening and closing the front cover several 
times and if the problem still occurs call the 
contact a service representative.

CONDITION POSSIBLE 
CAUSE SUGGESTED SOLUTIONS
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Toner specks • The paper may not meet specifications; for 
example, the paper is too moist or too 
rough. See page 16.

• The paper path may need cleaning. See 
"Cleaning the inside" on page 23.

Dropouts If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is 

uneven or the paper has moist spots on its 
surface. Try a different brand of paper. See 
page 16.

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of 
paper.

• Change the printer option and try again. Go 
to printer properties, click Paper tab, and 
set type to Thick Paper. Refer to the 
Software section for details.

If these steps do not correct the problem, 
contact a service representative.

White Spots White spots appear on the page:
• The paper is too rough and a lot of dirt from 

the paper falls to the inner devices within 
the machine, which means the transfer belt 
may be dirty. Clean the inside of your 
machine. Contact a service representative.

• The paper path may need cleaning. 
Contact a service representative.

Vertical lines If black vertical streaks appear on the page:
• The imaging unit has probably been 

scratched. Remove the imaging unit and 
install a new one. See page 27.

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty. Clean the LSU by 
opening and closing the front cover several 
times and if the problem still occurs call the 
contact a service representative.

CONDITION SUGGESTED SOLUTIONS
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Color or Black 
background

If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper. See 

page 16.
• Check the machine’s environment: very dry 

(low humidity) or high humidity (higher than 
80% RH) conditions can increase the 
amount of background shading.

• Remove the old toner cartridge and install 
a new one. See page 26.

Toner smear • Clean the inside of the machine. See page 
23.

• Check the paper type and quality. See page 
16.

• Remove the toner cartridge and install a 
new one. See page 26.

Vertical repetitive 
defects

If marks repeatedly appear on the printed side 
of the page at even intervals:
• The toner cartridge may be damaged. If a 

repetitive mark occurs on the page, print a 
cleaning sheet several times to clean the 
cartridge. After the printout, if you still have 
the same problems, remove the toner 
cartridge and install a new one. See page 
26.

• Parts of the machine may have toner on 
them. If the defects occur on the back of 
the page, the problem will likely correct 
itself after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Background scatter Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a different batch of paper. Do not open 
packages of paper until necessary so that 
the paper does not absorb too much 
moisture.

• If background scatter occurs on an 
envelope, change the printing layout to 
avoid printing over areas that have 
overlapping seams on the reverse side. 
Printing on seams can cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print resolution through your software 
application or the printer properties.

CONDITION SUGGESTED SOLUTIONS

A
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Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock 
may be too slick. Try a different paper. See 
page 16.

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. See page 

16.
• Ensure that the paper or other material is 

loaded correctly and the guides are not too 
tight or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl. See page 16.

• Turn over the stack of paper in the tray. Also 
try rotating the paper 180° in the tray.

Wrinkles or creases • Ensure that the paper is loaded properly.
• Check the paper type and quality. See page 

16.
• Turn over the stack of paper in the tray. Also 

try rotating the paper 180° in the tray.

Back of printouts 
are dirty

• Check for leaking toner. Clean the inside of 
the machine. See page 23.

CONDITION SUGGESTED SOLUTIONS
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Solid Color or 
Black pages

• The toner cartridge may not be installed 
properly. Remove the cartridge and reinsert 
it.

• The toner cartridge may be defective and 
need replacing. Remove the toner cartridge 
and install a new one. See page 26.

• The machine may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the machine. See page 
23.

• Check the paper type and quality. See page 
16.

• Remove the toner cartridge and install a 
new one. See page 26.

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Character Voids Character voids are white areas within parts of 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some 
character voids are normal. 

• You may be printing on the wrong surface 
of the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper 
specifications. See page 16.

Horizontal stripes If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a 
new one. See page 26.

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn over the stack of paper in the tray. 

Also try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to printer properties, click Paper tab, and 
set type to Thin Paper. Refer to the 
Software section for details.

An unknown image 
repetitively appears 
on a next few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your printer is probably being used at an 
altitude of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality 
such as loose toner or light imaging. You can 
set this option through Printer Settings Utility 
or Printer tab in printer driver’s properties. See 
page 15.

CONDITION SUGGESTED SOLUTIONS

A

A
AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc



Troubleshooting_ 37

Common Windows problems

Common Linux problems

CONDITION SUGGESTED SOLUTIONS

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the StartUp Group, then restart 
Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred.” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in ready mode 
or after printing has been completed, check the 
connection and/or whether an error has 
occurred.

Refer to the Microsoft Windows documentation that came with your 
computer for further information on Windows error messages.

CONDITION SUGGESTED SOLUTIONS

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator 
and switch to the Printers tab in Printers 
configuration window to look at the list of 
available printers. Make sure that your 
machine is displayed on the list. If not, 
please, invoke Add new printer wizard to set 
up your device. 

• Check if the printer is started. Open Printers 
configuration and select your machine on the 
printers list. Look at the description in the 
Selected printer pane. If its status contains 
“(stopped)” string, please, press the Start 
button. After that normal operation of the 
printer should be restored. The "stopped" 
status might be activated when some 
problems in printing occurred. 

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

Some color images 
come out all black.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.05) when the base color 
space of the document is indexed color space 
and it is converted through CIE color space. 
Because Postscript uses CIE color space for 
Color Matching System, you should upgrade 
Ghostscript on your system to at least GNU 
Ghostscript version 7.06 or later. You can find 
recent Ghostscript versions at 
www.ghostscript.com.

Some color images 
come out in 
unexpected color.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.xx) when the base color 
space of the document is indexed RGB color 
space and it is converted through CIE color 
space. Because Postscript uses CIE color 
space for Color Matching System, you should 
upgrade Ghostscript on your system to at least 
GNU Ghostscript version 8.xx or later. You can 
find recent Ghostscript versions at 
www.ghostscript.com.

The machine does 
not print whole pages 
and its output is half 
page printed.

It is a known problem that occurs when a color 
printer is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and reported to 
bugs.ghostscript.com as Ghostscript Bug 
688252.
The problem is solved in AFPL Ghostscript v. 
8.52 or above. Download the latest version of 
AFPL Ghostscript from http://sourceforge.net/
projects/ghostscript/ and install it to solve this 
problem.

I encounter error 
“Unable to open mfp 
port device file!” 
when printing a 
document.

Please avoid changing print job parameters (via 
LPR GUI, for example) while a print job is in 
progress. Known versions of CUPS server 
break the print job whenever print options are 
changed and then try to restart the job from the 
beginning. Since Unified Linux Driver locks mfp 
port while printing, the abrupt termination of the 
driver keeps the port locked and therefore 
unavailable for subsequent print jobs. If this 
situation occurred, please, try to release the 
mfp port.

When printing a 
document over the 
network in SuSE 9.2, 
the printer does not 
print.

The CUPS (Common Unix Printing System) 
version distributed with SuSE Linux 9.2 
(cups-1.1.21) has a problem with ipp 
(Internet Printing Protocol) printing. Use the 
socket printing instead of ipp or install later 
version of CUPS (cups-1.1.22 or higher).

Refer to Linux User’s Guide that came with your computer for further 
information on Linux error messages.

CONDITION SUGGESTED SOLUTIONS

http://www.ghostscript.com
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Common Macintosh problems

CONDITION SUGGESTED SOLUTIONS

The printer does not 
print PDF file correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and 
the Acrobat products:
Printing the PDF file as an image may 
solve this problem. Turn on Print As 
Image from the Acrobat printing options.

It will take longer to print when 
you print a PDF file as an image.

The document has 
printed, but the print job 
has not disappeared 
from the spooler in Mac 
OS 10.3.2.

Update your Mac OS to OS 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the Cover page 
printing.

This problem is caused because Mac OS 
cannot create the font during the Cover 
page printing. English alphabet and 
numbers are displayed normally at the 
Cover page.

Refer to Mac OS User’s Guide that came with your computer for 
further information on Mac OS error messages.
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ordering supplies and accessories
This chapter provides information on purchasing cartridges and accessories available for your machine.

This chapter includes:
• Supplies

SUPPLIES
When the toner runs out, you can order the following type of toner cartridge 
for your machine:

HOW TO PURCHASE
To order Founder-authorized supplies or accessories, contact your local 
Founder dealer or the retailer where you purchased your machine, or visit 
http://eshop.foundertech.com and select your country/region to obtain 
information on calling for technical support.

The optional parts or features may differ by countries. Contact your 
sales representatives whether the part you want is available in your 
country.

TYPE AVERAGE YIELD PART NUMBER

Standard yielda 
toner cartridge

a.Declared yield value in accordance with ISO/IEC 19798.

• Average 
continuous black 
cartridge yield: 
1,500 standard 
pages (Black)

• Average 
continuous color 
cartridge yield: 
1,000 standard 
pages (Yellow/
Magenta/Cyan)

FZ-D7010A
FZ-D7011A
FZ-D7012A
FZ-D7013A 

Standard yield  
Imaging Unit

Approx. 24,000 
imagesb

b. Image counts based on one color on each page. If you print documents 
in full color (Cyan, Magenta, Yellow, Black), the life of this item will be 
reduced by 25%.

FZ-D7014A

Waste toner 
container

Approx. 10,000 
imagesc

FZ-W7015A

When you purchase a new toner cartridge or supplies, you must 
purchase them in the same country you have purchased your 
machine.
Otherwise, the toner cartridge or supplies will be incompatible with 
your machine since the configuration of the toner cartridge or 
supplies vary depending on the countries.

http://eshop.foundertech.com
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specifications
This chapter guides you about this machine’s specifications such as various features.

This chapter include:
• General specifications • Printer specifications

GENERAL SPECIFICATIONS
The symbol * optional feature depending on machines.

ITEM DESCRIPTION

Paper input 
capacity

Tray: 150 sheets for plain paper, 75 g/m2 (20 lb bond)
For details about paper input capacity, see 17 page.

Paper output 
capacity

Face down: 100 sheets 75 g/m2 (20 lb bond)

Power rating AC 220 - 240 V
See the Rating label on the machine for the correct 
voltage, frequency (hertz) and type of current for your 
machine.

Power 
consumption

• Average operating mode: Less than 350 WH
• Ready mode: Less than 80 WH
• Power Save mode: Less than 10 WH
• Power off mode: 0 WH

Noise Levela Ready mode: Background noise level

Printing mode Black & White: Less than 47 dBA

Color: Less than 45 dBA

Default time to 
power save 
mode from 
ready mode

15 Minutes

Warm-up time Less than 35 seconds (Coldboot)

Operating 
environment

Temperature: 10 to 32 °C (50 to 90 °F)
Humidity: 20 to 80% RH

Toner 
cartridge lifeb

Black Average continuous black cartridge 
yield: 1,500 standard pages
(Shipped with 1,000 pages Starter 
toner cartridge.)c

Color
(Yellow/
Magenta/
Cyan)

Average continuous color cartridge 
yield: 1,000 standard pages
(shipped with 700 pages starter toner 
cartridge.)c 

Imaging Unit 
life

Approx. 24,000 imagesd

Waste toner 
container

Approx. 10,000 images

Memory 32 MB (Non-extendable)

External 
dimension
(W x D x H)

388 x 313 x 243 mm 
(15.3 x 12.3 x 9.6 inches)

Weight
(Including 
consumables)

11.41 Kg (25.16 lbs)

Package 
weight

Paper: 1.84 Kg (4.06 lbs)
Plastic: 0.26 Kg (0.57 lbs)

Fusing 
temperature

180 °C (356 °F)

a.Sound Pressure Level, ISO 7779
b.Declared yield value in accordance with ISO/IEC 19798. The number of 

pages may be affected by operating environment, printing interval, 
media type, and media size.

c. It varies depending on the product configuration.
d. Image counts based on one color on each page. If you print documents 

in full color (Black, Cyan, Magenta, Yellow), the life of this item will be 
reduced by 25%.

ITEM DESCRIPTION
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PRINTER SPECIFICATIONS

ITEM DESCRIPTION

Printing method Color laser beam printing

Printing speeda

a.It will be affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

• Black and white: Up to 16 ppm (A4), 17 ppm 
(Letter)

• Color: Up to 4 ppm (A4/Letter)

First print out 
time

Black & 
White

From ready: Less than 14 seconds

Color From ready: Less than 26 seconds

Print resolution Max. 2,400 x 600 dpi effective output

Printer language SPL-C

OS compatibilityb

b.Visit http://www.foundertech.com/service/index.htm to download the 
latest software version.

• Windows: 2000/XP/2003/Vista/2008
• Various Linux OS
• Macintosh: Mac OS X 10.3~10.5, Universal Mac

Interface High speed USB 2.0

http://www.foundertech.com/service/index.htm
http://www.foundertech.com/service/index.htm
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glossary

ADF
An Automatic Document Feeder (ADF) is a mechanism that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 
client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD 
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage 
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a pseudo standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a mechanism that will 
automatically feed and flip over an original sheet of paper so that the 
machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.

DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically flip over a sheet of paper so that the 
machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex can print double-sided of paper.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user's guide.
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An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that melts the toner onto the print media. It 
consists of a hot roller and a back-up roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 

Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over TCP/
IP.
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LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.  

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 00-00-0c-
34-11-4e). This address is usually hard-coded into a Network Interface 
Card (NIC) by its manufacturer, and used as an aid for routers trying to 
locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a codebook-
based run-length encoding scheme optimized to efficiently compress 
white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.

NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or gray colored and a cylinder shaped. 
An exposing unit of a drum is slowly worn away by its usage of the 
printer, and it should be replaced appropriately since it gets scratches 
from grits of a paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, matrix printer, and page 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used on a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated Inter-
process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, text-
based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.
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Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle within a machine like printer which contains toner. Toner 
is a powder used in laser printers and photocopiers, which forms the text 
and images on the printed paper. Toner can be melted by the heat of the 
fuser, causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a TWAIN-
compliant scanner with a TWAIN-compliant program, a scan can be 
initiated from within the program.; an image capture API for Microsoft 
Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.
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1 Installing Printer 
Software in Windows
This chapter includes:

• Installing Printer Software

• Changing the Software Language

• Removing Printer Software

NOTE: The following procedure is based on Windows XP, for 
other operating systems, refer to the corresponding Windows 
user's guide or online help.

Installing Printer Software
You can install the printer software for local printing or network 
printing. To install the printer software on the computer, 
perform the appropriate installation procedure depending on 
the printer in use.

A printer driver is software that lets your computer 
communicate with your printer. The procedure to install drivers 
may differ depending on the operating system you are using.

All applications should be closed on your PC before beginning 
installation. 

Installing Software for Local Printing
A local printer is a printer directly attached to your computer 
using the printer cable supplied with your printer, such as a 
USB.

You can install the printer software using the typical or custom 
method.

NOTE: If the “New Hardware Wizard” window appears during 
the installation procedure, click  in the upper right corner of 
the box to close the window, or click Cancel.

Typical Installation

This is recommended for most users. All components necessary 
for printer operations will be installed.
1 Make sure that the printer is connected to your computer 

and powered on.
2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.

• View User’s Guide: Allows you to view the User’s 
Guide. If your computer doesn’t have Adobe Acrobat, 
click on this option and it will automatically install Adobe 
Acrobat Reader for you.

4 Select Typical. Click Next.
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NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The installation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

5 After the installation is finished, a window asking you to 
print a test page appears. If you choose to print a test 
page, select the checkbox and click Next.

Otherwise, just click Next and skip to step 7.
6 If the test page prints out correctly, click Yes.

If not, click No to reprint it.
7 Click Finish.

NOTE: After setup is complete, if your printer driver doesn’t 
work properly, reinstall the printer driver.

Custom Installation

You can choose individual components to install.

1 Make sure that the printer is connected to your computer 
and powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.

The CD-ROM should automatically run, and an installation 
window appears.

If the installation window does not appear, click Start and 
then Run. Type X:\Setup.exe, replacing “X” with the 
letter which represents your drive and click OK.

If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.

If the AutoPlay window appears in Windows Vista, click 
Run Setup.exe in Install or run program field, and 
click Continue in the User Account Control window.

3 Click Next. 

• If necessary, select a language from the drop-down list.

• View User’s Guide: Allows you to view the User’s 
Guide. If your computer doesn’t have Adobe Acrobat, 
click on this option and it will automatically install Adobe 
Acrobat Reader for you.

4 Select Custom. Click Next.
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NOTE: If your printer is not already connected to the 
computer, the following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click 

Next, and No on the following screen. Then the installation 
will start and a test page will not be printed at the end of the 
installation.

• The installation window that appears in this User’s 
Guide may differ depending on the printer and 
interface in use.

5 Select the components to be installed and click Next.

NOTE: You can change the desired installation folder by 
clicking [Browse].

6 After the installation is finished, a window asking you to 
print a test page appears. If you choose to print a test 
page, select the checkbox and click Next.

Otherwise, just click Next and skip to step 8.

7 If the test page prints out correctly, click Yes.

If not, click No to reprint it.

8 Click Finish.
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Changing the Software 
Language
After installation of the software, you can change the display 
language. 
1 Click the Windows Start menu.

2 Select Programs or All Programs and then your printer 
driver name.

3 Select Language Selection.

4 Select the desired language from the language selection 
window, and click OK.

Removing Printer Software

1 Start Windows.

2 From the Start menu select Programs or All Programs 
→ your printer driver name → Maintenance.

3 Select Remove and click Next.

You will see a component list so that you can remove any 
item individually.

4 Select the components you want to remove and then click 
Next.

5 When your computer asks you to confirm your selection, 
click Yes.

The selected driver and all of its components are removed 
from your computer.

6 After the software is removed, click Finish.
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2 Basic Printing 
This chapter explains the printing options and common printing 
tasks in Windows. 

This chapter includes:

• Printing a Document

• Printing to a file (PRN)

• Printer Settings

- Layout Tab

- Paper Tab

- Graphics Tab

- Extras Tab

- About Tab

- Printer Tab

- Using a Favorite Setting

- Using Help

Printing a Document

NOTES: 
• Your printer driver Properties window that appears in this 

User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• Check the Operating System(s) that are compatible 
with your printer. Please refer to the OS Compatibility 
section of Printer Specifications in your Printer User’s 
Guide.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

• When you select an option in printer properties, you may see 

an exclamation mark or mark. An exclamation mark 
means you can select that certain option but it is not 

recommended, and mark means you cannot select that 
option due to the machineís setting or environment.

The following procedure describes the general steps required 
for printing from various Windows applications. The exact steps 
for printing a document may vary depending on the application 
program you are using. Refer to the User’s Guide of your 
software application for the exact printing procedure.

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is 
displayed. It may look slightly different depending on your 
application. 

The basic print settings are selected within the Print 
window. These settings include the number of copies and 
print range.

3 Select your printer driver from the Name drop-down 
list.

To take advantage of the printer features provided by your 
printer driver, click Properties or Preferences in the 
application’s Print window. For details, see “Printer 
Settings” on page 9.

If you see Setup, Printer, or Options in your Print 
window, click it instead. Then click Properties on the next 
screen.

Click OK to close the printer properties window.
4 To start the print job, click OK or Print in the Print 

window.

Make sure that your 
printer is selected.
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Printing to a file (PRN)  
You will sometimes need to save the print data as a file for your 
purpose. 

To create a file:
1 Check the Print to file box at the Print window.

2 Select the folder and assign a name of the file and then 
click OK.

Printer Settings
You can use the printer properties window, which allows you to 
access all of the printer options you need when using your 
printer. When the printer properties are displayed, you can 
review and change the settings needed for your print job. 

Your printer properties window may differ, depending on your 
operating system. This Software User’s Guide shows the 
Properties window for Windows XP.

Your printer driver Properties window that appears in this 
User’s Guide may differ depending on the printer in use.

If you access printer properties through the Printers folder, you 
can view additional Windows-based tabs (refer to your 
Windows User’s Guide) and the Printer tab (see “Printer Tab” on 
page 13).

NOTES:
• Most Windows applications will override settings you specify 

in the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are 
using the current program. To make your changes 
permanent, make them in the Printers folder. 

• The following procedure is for Windows XP. For other 
Windows OS, refer to the corresponding Windows User's 
Guide or online help.
1. Click the Windows Start button.
2. Select Printers and Faxes.
3. Select your printer driver icon.
4. Right-click on the printer driver icon and select 

Printing Preferences.
5. Change the settings on each tab, click OK.
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Layout Tab
The Layout tab provides options to adjust how the document 
appears on the printed page. The Layout Options includes 
Multiple Pages per Side,  Poster Printing and Booklet 
Printing. See “Printing a Document” on page 8 for more 
information on accessing printer properties.  

Paper Orientation
Paper Orientation allows you to select the direction in which 
information is printed on a page. 
• Portrait prints across the width of the page, letter style. 
• Landscape prints across the length of the page, spreadsheet 

style. 
• Rotate 180 Degrees allows you to rotate the page, 180 

degrees.

Layout Options
Layout Options allows you to select advanced printing options. 
You can choose Multiple Pages per Side and Poster Printing.
• For details, see “Printing Multiple Pages on One Sheet of Paper 

(N-Up Printing)” on page 14.
• For details, see “Printing Posters” on page 15
• For details, see “Printing Booklets” on page 15

Double-sided Printing (Manual)
Double-sided Printing (Manual) allows you to print on both 
sides of paper. If this option does not appear, your printer 
does not have this feature.
• For details, see “Printing on Both Sides of Paper” on page 16.

 Landscape Portrait

Paper Tab
Use the following options to set the basic paper handling 
specifications when you access the printer properties. See 
“Printing a Document” on page 8 for more information on 
accessing printer properties. 

Click the Paper tab to access various paper properties. 

Copies
Copies allows you to choose the number of copies to be printed. 
You can select 1 to 999 copies. 

Paper Options

Size
Size allows you to set the size of paper you loaded in the tray. 
If the required size is not listed in the Size box, click Custom. 
When the Custom Paper Setting window appears, set the paper 
size and click OK. The setting appears in the list so that you can 
select it. 

Source
Make sure that Source is set to the corresponding paper tray.
Use Manual Feeder when printing on special materials like 
envelopes and transparencies. 

Type
Set Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality 
printout. If not, print quality may not be acheived as you want.
Thick: 24 lb to 28 lb (90~105 g/m2) thick paper.  
Thin: 16 lb to 19 lb (60~70 g/m2) thin paper.  
Cotton: 20 lb to 24 lb (75~90 g/m2) cotton paper such as Gilbert 
25 % and Gilbert 100 %. 
Plain: Normal plain paper. Select this type if your printer is 
monochrome and printing on the 16 lb (60 g/m2) cotton paper. 
Recycled: 20 lb to 24 lb (75~90 g/m2) recycled paper.
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Color: 20 lb to 24 lb (75~90 g/m2) color-backgrounded paper.  
Archive: If you need to keep print-out for a long period time 
such as archives, select this option.
Glossy Photo 160 g/m2 (Glossy Photo 44 lb): 44 lb (160 g/m2) 
glossy paper.

Scaling Printing
Scaling Printing allows you to automatically or manually scale 
your print job on a page. You can choose from None, Reduce/
Enlarge, and Fit to Page. 
• For details, see “Printing a Reduced or Enlarged Document” on 

page 16.
• For details, see “Fitting Your Document to a Selected Paper 

Size” on page 16.

Graphics Tab
Use the following Graphic options to adjust the print quality for 
your specific printing needs. See “Printing a Document” on 
page 8 for more information on accessing printer properties. 

Click the Graphic tab to display the properties shown below.

Quality
The Quality options you can select may vary depending 
on your printer model. The higher the setting, the sharper the 
clarity of printed characters and graphics. The higher setting also 
may increase the time it takes to print a document. 

Color Mode
You can choose color options. Setting to Color typically produces 
the best possible print quality for color documents. If you want to 
print a color document in grayscale, select Grayscale. If you 
want to adjust the color options manually, select Manual and 
click the Color Adjust or Color Matching button.
• Copies Setting: In order to use this option, first you need to 

set total number of copies from Paper tab. When you make 
several copies, and if you want to print some copies in color and 
some in grayscale, use this option and select the number of 
copies in grayscale.

• Color Adjust: You can adjust the appearance of images by 
changing the settings in the Levels option.

• Color Matching: You can adjust the appearance of images by 
changing the settings in the Settings option.
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Advanced Options

You can set advanced settings by clicking the Advanced 
Options button. 
• Print All Text To Black: When the Print All Text To 

Black option is checked, all text in your document prints solid 
black, regardless of the color it appears on the screen. 

• Print All Text To Darken: When the Print All Text To 
Darken option is checked, all text in your document is allowed 
to print darker than on a normal document. Some printers do 
not support this feature. 

• Grayscale Enhancement: Press the Smart Color tab. It 
allows users to preserve the details of nature photos, and 
improve contrast and readability among gray scaled 
colors, when printing color documents in grayscale. 

• Fine Edge: Press the Smart Color tab. It allows users to 
emphasize edges of texts and fine lines for improving 
readability and align each color channel registration in color 
printing mode. 

Extras Tab
You can select output options for your document. See “Printing 
a Document” on page 8 for more information about accessing 
the printer properties.

Click the Extras tab to access the following feature:  

Watermark
You can create a background text image to be printed on each 
page of your document. For details, see “Using Watermarks” on 
page 17.

Overlay
Overlays are often used to take the place of preprinted forms and 
letterhead paper. For details, see “Using Overlays” on page 18.

Output Options
• Print Subset: You can set the sequence in which the pages 

print. Select the print order from the drop-down list.
- Normal (1,2,3): Your printer prints all pages from the first 
page to the last page.

- Reverse All Pages (3,2,1): Your printer prints all pages 
from the last page to the first page.

- Print Odd Pages: Your printer prints only the odd numbered 
pages of the document.

- Print Even Pages: Your printer prints only the even 
numbered pages of the document.
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About Tab
Use the About tab to display the copyright notice and the 
version number of the driver. If you have an Internet browser, 
you can connect to the Internet by clicking on the web site icon. 
See “Printing a Document” on page 8 for more information 
about accessing printer properties.

Printer Tab
If you access printer properties through the Printers folder, 
you can view the Printer tab. You can set the printer 
configuration.

The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.
1 Click the Windows Start menu. 

2 Select Printers and Faxes.

3 Select your printer driver icon. 

4 Right-click on the printer driver icon and select 
Properties.

5 Click the Printer tab and set the options.  

Using a Favorite Setting  
The Favorites option, which is visible on each properties tab, 
allows you to save the current properties settings for future 
use. 

To save a Favorites item:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 

When you save Favorites, all current driver settings are 
saved.

To use a saved setting, select the item from the Favorites drop 
down list. The printer is now set to print according to the 
Favorites setting you selected. 

To delete a Favorites item, select it from the list and click 
Delete. 

You can also restore the printer driver’s default settings by 
selecting Printer Default from the list. 

Using Help
Your printer has a help screen that can be activated by clicking 
the Help button in the printer properties window. These help 
screens give detailed information about the printer features 
provided by the printer driver.

You can also click  from the upper right corner of the window, 
and then click on any setting. 
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3 Advanced Printing
This chapter explains printing options and advanced printing 
tasks. 

NOTE: 
• Your printer driver Properties window that appears in this 

User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

This chapter includes:

• Printing Multiple Pages on One Sheet of Paper (N-Up 
Printing)

• Printing Posters

• Printing Booklets

• Printing on Both Sides of Paper

• Printing a Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Using Watermarks

• Using Overlays

Printing Multiple Pages on One 
Sheet of Paper (N-Up Printing) 
You can select the number of pages to print on a single sheet 
of paper. To print more than one page per sheet, the pages will 
be reduced in size and arranged in the order you specify. You 
can print up to 16 pages on one sheet.  

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 8.

2 From the Layout tab, choose Multiple Pages per Side in 
the Layout Type drop-down list. 

3 Select the number of pages you want to print per sheet 
(1, 2, 4, 6, 9, or 16) in the Pages per Side drop-down 
list.

4 Select the page order from the Page Order drop-down 
list, if necessary. 

Check Print Page Border to print a border around each 
page on the sheet. 

5 Click the Paper tab, select the paper source, size, and 
type.

6 Click OK and print the document. 

1 2

3 4
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Printing Posters
This feature allows you to print a single-page document onto 4, 
9, or 16 sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

NOTE: The poster printing option is available when 600 dpi is 
selected in the resolution option on the Graphic tab.

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 8.

2 Click the Layout tab, select Poster Printing in the 
Layout Type drop-down list.

3 Configure the poster option:

You can select the page layout from Poster<2x2>, 
Poster<3x3> or Poster<4x4>. If you select 
Poster<2x2>, the output will be automatically stretched 
to cover 4 physical pages.

 

Specify an overlap in millimeters or inches to make it 
easier to pasting the sheets together. 

4 Click the Paper tab, select the paper source, size, and 
type.

5 Click OK and print the document. You can complete the 
poster by pasting the sheets together. 

0.15 inches

0.15 inches

Printing Booklets 

This printer feature allows you to print your document on both 
sides of the paper and arranges the pages so that the paper can 
be folded in half after printing to produce a booklet. 
1 To change the print settings from your software 

application, access the printer properties. See “Printing a 
Document” on page 8.

2 From the Layout tab, choose Booklet Printing from the 
Layout Type drop-down list. 

NOTE: The Booklet Printing option is not available for all 
paper sizes. In order to find out the available paper size for 
this feature, select the paper size in the Size option on the 
Paper tab, then check if the Booklet Printing in a Layout 
Type drop-down list on the Layout tab is activated.

3 Click the Paper tab, and select the paper source, size, and 
type.

4 Click OK and print the document.

5 After printing, fold and staple the pages. 

8 9
8 9
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Printing on Both Sides of Paper
You can print on both sides of a sheet of paper. Before printing, 
decide how you want your document oriented.

The options are:

• None

• Long Edge, which is the conventional layout used in 
book binding.

• Short Edge, which is the type often used with calendars.

NOTE: 
• Do not print on both sides of labels, transparencies, 

envelopes, or thick paper. Paper jamming and damage to the 
printer may result. 

1 To change the print settings from your software 
application, access printer properties. “Printing a 
Document” on page 8.

2 From the Layout tab, select the paper orientation.

3 From the Double-sided Printing (Manual) section, 
select the binding option you want.     

4 Click the Paper tab and select the paper source, size, and 
type.

5 Click OK and print the document.

NOTE: If your printer does not have a duplex unit, you should 
complete the printing job manually. The printer prints every 
other page of the document first. After printing the first side of 
your job, the Printing Tip window appears. Follow the on-
screen instructions to complete the printing job.

 Long Edge▲  Short Edge▲

2 5
3

2

5
3

2 5
3

2

5
3

Printing a Reduced or Enlarged 
Document 
You can change the size of a page’s content to appear larger or 
smaller on the printed page. 

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 8. 

2 From the Paper tab, select Reduce/Enlarge in the 
Printing Type drop-down list. 

3 Enter the scaling rate in the Percentage input box.

You can also click the  or  button.
4 Select the paper source, size, and type in Paper Options. 

5 Click OK and print the document. 

Fitting Your Document to a 
Selected Paper Size
This printer feature allows you to scale your print job to any 
selected paper size regardless of the digital document size. This 
can be useful when you want to check fine details on a small 
document. 

1 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 8.

2 From the Paper tab, select Fit to Page in the Printing 
Type drop-down list. 

3 Select the correct size from the Output size drop-down 
list.

4 Select the paper source, size, and type in Paper Options.

5 Click OK and print the document.

A
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Using Watermarks
The Watermark option allows you to print text over an existing 
document. For example, you may want to have large gray 
letters reading “DRAFT” or “CONFIDENTIAL” printed diagonally 
across the first page or all pages of a document. 

There are several predefined watermarks that come with the 
printer, and they can be modified, or you can add new ones to 
the list. 

Using an Existing Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 8. 

2 Click the Extras tab, and select the desired watermark 
from the Watermark drop-down list. You will see the 
selected watermark in the preview image. 

3 Click OK and start printing. 

NOTE: The preview image shows how the page will look when 
it is printed.

Creating a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 8. 

2 Click the Extras tab, and click the Edit button in the 
Watermark section. The Edit Watermark window 
appears. 

3 Enter a text message in the Watermark Message box. 
You can enter up to 40 characters. The message displays 
in the preview window.

When the First Page Only box is checked, the watermark 
prints on the first page only.

4 Select watermark options. 

You can select the font name, style, size, or grayscale level 
from the Font Attributes section and set the angle of the 
watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list.   

6 When you have finished editing, click OK and start 
printing. 

To stop printing the watermark, select (No Watermark) from 
the Watermark drop-down list. 

Editing a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 8. 

2 Click the Extras tab and click the Edit button in the 
Watermark section. The Edit Watermark window 
appears.

3 Select the watermark you want to edit from the Current 
Watermarks list and change the watermark message and 
options. 

4 Click Update to save the changes.

5 Click OK until you exit the Print window. 

Deleting a Watermark
1 To change the print settings from your software 

application, access printer properties. See “Printing a 
Document” on page 8.

2 From the Extras tab, click the Edit button in the 
Watermark section. The Edit Watermark window 
appears. 

3 Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4 Click OK until you exit the Print window.
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Using Overlays

What is an Overlay?
An overlay is text and/or images stored in the computer hard 
disk drive (HDD) as a special file format that can be printed on 
any document. Overlays are often used to take the place of 
preprinted forms and letterhead paper. Rather than using 
preprinted letterhead, you can create an overlay containing the 
exact same information that is currently on your letterhead. To 
print a letter with your company’s letterhead, you do not need 
to load preprinted letterhead paper in the printer. You need only 
tell the printer to print the letterhead overlay on your 
document.

Creating a New Page Overlay
To use a page overlay, you must create a new page overlay 
containing your logo or image.

1 Create or open a document containing text or an image for 
use in a new page overlay. Position the items exactly as 
you wish them to appear when printed as an overlay.

2 To save the document as an overlay, access printer 
properties. See “Printing a Document” on page 8.

3 Click the Extras tab, and click Edit button in the Overlay 
section. 

4 In the Edit Overlay window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to eight 
characters in the File name box. Select the destination 
path, if necessary. (The default is C:\Formover).

6 Click Save. The name appears on the Overlay List box. 

7 Click OK or Yes to finish creating. 

The file is not printed. Instead it is stored on your 
computer hard disk drive. 

NOTE: The overlay document size must be the same as the 
documents you print with the overlay. Do not create an overlay 
with a watermark. 

WORLD BEST

Dear ABC

Regards

WORLD BEST

Using a Page Overlay
After an overlay has been created, it is ready to be printed with 
your document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 To change the print settings from your software 
application, access printer properties. See “Printing a 
Document” on page 8. 

3 Click the Extras tab. 

4 Select the desired overlay from the Overlay drop-down 
list box. 

5 If the overlay file you want does not appear in the 
Overlay list, click Edit button and Load Overlay, and 
select the overlay file. 

If you have stored the overlay file you want to use in an 
external source, you can also load the file when you access 
the Load Overlay window. 

After you select the file, click Open. The file appears in the 
Overlay List box and is available for printing. Select the 
overlay from the Overlay List box. 

6 If necessary, click Confirm Page Overlay When 
Printing. If this box is checked, a message window 
appears each time you submit a document for printing, 
asking you to confirm your wish to print an overlay on your 
document. 

If this box is not checked and an overlay has been 
selected, the overlay automatically prints with your 
document. 

7 Click OK or Yes until printing begins. 

The selected overlay downloads with your print job and 
prints on your document. 

NOTE: The resolution of the overlay document must be the 
same as that of the document you will print with the overlay. 

Deleting a Page Overlay
You can delete page overlays that you no longer use. 

1 In the printer properties window, click the Extras tab. 

2 Click the Edit button in the Overlay section. 

3 Select the overlay you want to delete from the Overlay 
List box. 

4 Click Delete Overlay. 

5 When a confirming message window appears, click Yes.

6 Click OK until you exit the Print window.
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4 Sharing the Printer 
Locally
You can connect the printer directly to a selected computer, 
which is called “host computer,” on the network. 

The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.

NOTES: 
• Check the Operating System(s) that are compatible with 

your printer. Please refer to the OS Compatibility section of 
Printer Specifications in your Printer User’s Guide.

• If you need to know the exact name of your printer, you can 
check the supplied CD-ROM.

Setting Up a Host Computer

1 Start Windows. 

2 From the Start menu select Printers and Faxes. 

3 Double-click your printer driver icon. 

4 From the Printer menu, select Sharing. 

5 Check the Share this printer box.

6 Fill in the Shared Name field, and then click OK.

Setting Up a Client Computer 

1 Right-click the Windows Start button and select Explore.

2 Select My Network Places  and then right-click Search 
for Computers.

3 Fill in the IP address of host computer in Computer name 
field, and click Search. (In case host computer requires 
User name and Password, fill in User ID and password 
of host computer account.)

4 Double-click Printers and Faxes.

5 Right-click printer driver icon, select Connect.

6 Click Yes, if the installation confirm message appears.
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5 Using Utility Applications
If an error occurs while printing, the Status Monitor window appears, 
showing the error. 

NOTES:
• To use this program, you need:

- To check for Operating System(s) that are compatible with your 
printer, refer to Printer Specifications in your Printer User’s Guide.

- Internet Explorer version 5.0 or higher for flash animation in HTML 
Help.

• If you need to know the exact name of your printer, you can check the 
supplied CD-ROM.

Using Printer Settings Utility
Using the Printer Settings Utility, you can configure and check print 
settings. 

1 From the Start menu, select Programs or All Programs  → your 
printer driver icon → Printer Settings Utility.

2 Change the settings. 

3 To send the changes to the printer, click the Apply button.

Using Onscreen Help
For more information about Printer Settings Utility, click  . 

Opening the Troubleshooting Guide
Double click the Status Monitor icon on the Windows task bar.

Or, from the Start menu, select Programs or All Programs  → your 
printer driver icon → Troubleshooting Guide.

Double click this icon.

Changing the Status Monitor Program 
Settings
Right-click  (in Windows) or click (in Mac OS X) the Status Monitor icon 
and select Options. Select the settings you want from the Options 
window.



Using Your Printer in Linux
21

6 Using Your Printer in 
Linux 
You can use your machine in a Linux environment. 

This chapter includes:

• Getting Started

• Installing the Unified Linux Driver

• Using the Unified Driver Configurator

• Configuring Printer Properties

• Printing a Document

Getting Started
The supplied CD-ROM provides you with Founder’s Unified Linux 
Driver package for using your machine with a Linux computer.

After the driver is installed on your Linux system, the driver 
package allows you to monitor a number of machine devices via 
fast ECP parallel ports and USB simultaneously. 

The Unified Linux Driver package is supplied with a smart and 
flexible installation program. You don't need to search for 
additional components that might be necessary for the Unified 
Linux Driver software: all required packages will be carried onto 
your system and installed automatically; this is possible on a 
wide set of the most popular Linux clones.

Installing the Unified Linux 
Driver

Installing the Unified Linux Driver
1 Make sure that you connect your machine to your 

computer. Turn both the computer and the machine on.
2 When the Administrator Login window appears, type in 

root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to install the 
printer software. If you are not a super user, ask your system 
administrator.

3 Insert the printer software CD-ROM. The CD-ROM will 
automatically run.

If the CD-ROM does not automatically run, click the  
icon at the bottom of the desktop. When the Terminal 
screen appears, type in:

If the CD-ROM is secondary master and the location to 
mount is /mnt/cdrom,

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/
cdrom

[root@localhost root]#cd /mnt/cdrom/Linux

[root@localhost Linux]#./install.sh 

If you still failed to run the CD-ROM, type teh followings 
in sequence:

[root@localhost root]#umount /dev/hdc

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/
cdrom

NOTE: The installation program runs automatically if you 
have an autorun software package installed and configured.
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4 When the welcome screen appears, click Next.

5 When the installation is complete, click Finish.

The installation program has added the Unified Driver 
Configurator desktop icon and Founder Unified Driver 
group to the system menu for your convenience. If you 
have any difficulties, consult the onscreen help that is 
available through your system menu or can otherwise be 
called from the driver package windows applications, 
such as Unified Driver Configurator.

NOTE: Installing the driver in the text mode:
• If you do not use the graphical interface or have failed the 

driver installation, you have to use the driver in the text 
mode.

• Follow the step 1 to 3, then type [root@localhost Linux]# ./
install.sh, then follow the instruction on the terminal screen. 
Then the installation completes.

• When you wan to uninstall the driver, follow the installation 
instruction above, but type [root@localhost Linux]# ./
uninstall.sh on the terminal screen.

Uninstalling the Unified Linux Driver
1 When the Administrator Login window appears, type in 

root in the Login field and enter the system password.

NOTE: You must log in as a super user (root) to uninstall the 
printer software. If you are not a super user, ask your system 
administrator.

2 Insert the printer software CD-ROM. The CD-ROM will 
automatically run.

If the CD-ROM does not automatically run, click the  
icon at the bottom of the desktop. When the Terminal 
screen appears, type in:

If the CD-ROM is secondary master and the location to 
mount is /mnt/cdrom,

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/
cdrom

[root@localhost root]#cd /mnt/cdrom/Linux

[root@localhost Linux]#./uninstall.sh 

NOTE: The installation program runs automatically if you 
have an autorun software package installed and configured.

3 Click Uninstall.

4 Click Next. 

5 Click Finish.
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Using the Unified Driver 
Configurator
Unified Linux Driver Configurator is a tool primarily intended for 
configuring Printer.

After installing the Unified Linux driver, the Unified Linux Driver 
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver 
Configurator
1 Double-click Unified Driver Configurator on the 

desktop.

You can also click the Startup Menu icon and select 
Founder Unified Driver and then Unified Driver 
Configurator.

2 Press each button on the Modules pane to switch to the 
corresponding configuration window. 

You can use the onscreen help by clicking Help.
3 After changing the configurations, click Exit to close the 

Unified Driver Configurator.

Printers Configuration button

Ports Configuration button

Printers Configuration
Printers configuration has the two tabs: Printers and Classes. 

Printers Tab
You can see the current system’s printer configuration by 
clicking on the printer icon button on the left side of the Unified 
Driver Configurator window.

You can use the following printer control buttons:

• Refresh: renews the available printers list.

• Add Printer: allows you to add a new printer.

• Remove Printer: removes the selected printer.

• Set as Default: sets the current printer as a default 
printer.

• Stop/Start: stops/starts the printer.

• Test: allows you to print a test page to check if the 
machine is working properly.

• Properties: allows you to view and change the printer 
properties. For details, see page 24.

Shows all of the 
installed printer.

Switches to Printer 
configuration.

Shows the status, 
model name and 
URI of your printer.
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Classes Tab
The Classes tab shows a list of available printer classes.

• Refresh : Renews the classes list.

• Add Class... : Allows you to add a new printer class.

• Remove Class : Removes the selected printer class.

Ports Configuration
In this window, you can view the list of available ports, check 
the status of each port and release a port that is stalled in busy 
state when its owner is terminated for any reason.

• Refresh : Renews the available ports list.

• Release port : Releases the selected port.

Shows the status of the 
class and the number of 
printers in the class.

Shows all of the 
printer classes.

Switches to 
ports 
configuration.

Shows the port type, 
device connected to 
the port and status

Shows all of the 
available ports.

Configuring Printer Properties
Using the properties window provided by the Printers 
configuration, you can change the various properties for your 
machine as a printer.
1 Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2 Select your machine on the available printers list and click 

Properties.
3 The Printer Properties window opens.

The following five tabs display at the top of the window:
•General: allows you to change the printer location and 
name. The name entered in this tab displays on the 
printer list in Printers configuration.

•Connection: allows you to view or select another port. If 
you change the printer port from USB to parallel or vice 
versa while in use, you must re-configure the printer port 
in this tab.

•Driver: allows you to view or select another printer 
driver. By clicking Options, you can set the default 
device options.

•Jobs: shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed 
jobs check box to see previous jobs on the job list.

•Classes: shows the class that your printer is in. Click 
Add to Class to add your printer to a specific class or 
click Remove from Class to remove the printer from the 
selected class.

4 Click OK to apply the changes and close the Printer 
Properties Window.
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Printing a Document

Printing from Applications
There are a lot of Linux applications that you are allowed to 
print from using Common UNIX Printing System (CUPS). You 
can print on your machine from any such application.
1 From the application you are using, select Print from the 

File menu.
2 Select Print directly using lpr.

3 In the LPR GUI window, select the model name of your 
machine from the Printer list and click Properties.

4 Change the printer and print job properties.

Click.

The following four tabs display at the top of the window.
•General - allows you to change the paper size, the paper 
type, and the orientation of the documents, enables the 
duplex feature, adds start and end banners, and changes 
the number of pages per sheet.

•Text - allows you to specify the page margins and set the 
text options, such as spacing or columns.

•Graphics - allows you to set image options that are used 
when printing images/files, such as color options, image 
size, or image position.

•Advanced: this option allows you to set the print 
resolution, paper source and special print features.

5 Click Apply to apply the changes and close the Properties 
window. 

6 Click OK in the LPR GUI window to start printing.

7 The Printing window appears, allowing you to monitor the 
status of your print job.

To abort the current job, click Cancel.

Printing Files
You can print many different types of files on the Founder 
machine device using the standard CUPS way - directly from 
the command line interface. The CUPS lpr utility allows you do 
that. But the drivers package replaces the standard lpr tool by 
a much more user-friendly LPR GUI program.

To print any document file:
1 Type lpr <file_name> from the Linux shell command 

line and press Enter. The LPR GUI window appears.

When you type only lpr and press Enter, the Select 
file(s) to print window appears first. Just select any files 
you want to print and click Open. 

2 In the LPR GUI window, select your printer from the list, 
and change the printer and print job properties.

For details about the properties window, see page 25.
3 Click OK to start printing.
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7 Using Your Printer with 
a Macintosh
Your printer supports Macintosh systems with a built-in USB 
interface or 10/100 Base-TX network interface card. When you 
print a file from a Macintosh computer, you can use the CUPS driver 
by installing the PPD file. 

NOTE: Some printers do not support a network 
interface. Make sure that your printer supports a 
network interface by referring to Printer Specifications 
in your Printer User’s Guide.

This chapter includes:

• Installing Software

• Setting Up the Printer

• Printing

Installing Software
The CD-ROM that came with your printer provides you with the 
PPD file that allows you to use the CUPS driver or Apple 
LaserWriter driver (only available when you use a printer 
which supports the PostScript driver), for printing on a 
Macintosh computer. 

Printer driver

Installing the Printer driver
1 Make sure that you connect your printer to the computer. 

Turn on your computer and printer.

2 Insert the CD-ROM which came with your printer into the 
CD-ROM drive.

3 Double-click CD-ROM icon that appears on your 
Macintosh desktop.

4 Double-click the MAC_Installer folder.

5 Double-click the Installer OS X icon.

6 Enter the password and click OK.

7 The Installer OS X window opens. Click Continue and 
then click Continue.

8 Select Easy Install and click Install. Easy Install is 
recommended for most users. All components necessary 
for printer operations will be installed. 
If you select Custom Install, you can choose individual 
components to install.

9 The message which warns all application will close on your 
computer appears, Click Continue.

10After the installation is finished, click Quit.

Uninstalling the Printer driver
Uninstall is required if you are upgrading the software, or if 
installation fails.
1 Insert the CD-ROM which came with your printer into the 

CD-ROM drive.

2 Double-click CD-ROM icon that appears on your 
Macintosh desktop.

3 Double-click the MAC_Installer folder.

4 Double-click the Installer OS X icon.

5 Enter the password and click OK.

6 The Installer OS X window opens. Click Continue and 
then click Continue.

7 Select Uninstall and then click Uninstall.

8 The message which warns all application will close on your 
computer appears, Click Continue.

9 When the uninstallation is done, click Quit.
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Setting Up the Printer 

For a USB-connected
1 Follow the instructions on “Installing Software” on page 26 

to install the PPD and Filter files on your computer.

2 Open the Applications folder → Utilities, and Print 
Setup Utility.

•For MAC OS 10.5, open System Preferences from the 
Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.

•For MAC OS 10.5, press the “+” icon then a display 
window will pop up. 

4 For MAC OS 10.3, select the USB tab. 

•For MAC OS 10.4, click Default Browser and find the 
USB connection.

•For MAC OS 10.5, click Default and find the USB 
connection.

5 For MAC OS 10.3, if Auto Select does not work properly, 
select Founder in Printer Model and your printer name 
in Model Name. 

•For MAC OS 10.4, if Auto Select does not work properly, 
select Founder in Print Using and your printer name 
in Model. 

•For MAC OS 10.5, if Auto Select does not work properly, 
select Select a driver to use... and your printer name 
in Print Using. 

Your machine appears on the Printer List and is set as the 
default printer.

6 Click Add.
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Printing 

NOTES: 
• The Macintosh printer’s properties window that appears in 

this User’s Guide may differ depending on the printer in use. 
However the composition of the printer properties window is 
similar.

• You can check your printer name in the supplied CD-
ROM.

Printing a Document
When you print with a Macintosh, you need to check the printer 
software setting in each application you use. Follow these steps 
to print from a Macintosh.

1 Open a Macintosh application and select the file you want 
to print.

2 Open the File menu and click Page Setup (Document 
Setup in some applications). 

3 Choose your paper size, orientation, scaling, and other 
options and click OK.

4 Open the File menu and click Print.

5 Choose the number of copies you want and indicate which 
pages you want to print. 

6 Click Print when you finish setting the options.

▲ Mac OS 10.3

Make sure that your 
printer is selected.

Changing Printer Settings
You can use advanced printing features when using your 
printer.

From your Macintosh application, select Print from the File 
menu. The printer name which appears in the printer properties 
window may differ depending on the printer in use. Except for 
the name, the composition of the printer properties window is 
similar.

NOTES: The setting options may differ depending on printers 
and Macintosh OS version.

Layout
The Layout tab provides options to adjust how the document 
appears on the printed page. You can print multiple pages on 
one sheet of paper. Select Layout from the Presets drop-down 
list to access the following features.

•Pages per Sheet: This feature determines how many 
pages printed on one page. For details, see "Printing 
Multiple Pages on One Sheet of Paper" on the next 
column.

•Layout Direction: You can select the printing direction 
on a page as like the examples on UI.

▲ Mac OS 10.4
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Graphics

The Graphics tab provides options for selecting Quality and 
Color Mode. Select Graphics form the Presets' drop-down 
list to access the graphic features.

•Quality: You can select the printing resolution. The 
higher the setting, the sharper the clarity of printed 
characters and graphics. The higher setting also may 
increase the time it takes to print a document.

•Color Mode: You can set the color options. Setting to 
Color typically produces the best possible print quality 
for color documents. If you want to print a color 
document in grayscale, select Grayscale.

Paper

Set Paper Type to correspond to the paper loaded in the tray 
from which you want to print. This will let you get the best 
quality printout. If you load a different type of print material, 
select the corresponding paper type.

▲ Mac OS 10.4

▲ Mac OS 10.4

Printing Multiple Pages on One Sheet 
of Paper
You can print more than one page on a single sheet of paper. 
This feature provides a cost-effective way to print draft pages.

1 From your Macintosh application, select Print from the 
File menu. 

2 Select Layout.

3 Select the number of pages you want to print on one sheet 
of paper on the Pages per Sheet drop-down list.

4 Select the page order from the Layout Direction option.

To print a border around each page on the sheet, select 
the option you want from the Border drop-down list.

5 Click Print, and the printer prints the selected number of 
pages on one side of each page.

▲ Mac OS 10.4
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SOFTWARE SECTION 
INDEX

A
advanced printing, use 14

B
booklet printing 15

D
document, print

Macintosh 28
Windows 8

double-sided printing 16

E
Extras properties, set 12

F
favorites settings, use 13

G
Graphics properties, set 11

H
help, use 13

I
install

printer driver
Macintosh 26
Windows 4

installing
Linux software 21

L
language, change 7
Layout properties, set

Windows 10
Linux

driver, install 21
printer properties 24
printing 25

M
Macintosh

driver
install 26
uninstall 26

printing 28
setting up the printer 27

MFP driver, install
Linux 21

N
n-up printing

Macintosh 29
Windows 14

O
orientation, print 25

Windows 10
overlay

create 18
delete 18
print 18

P
Paper properties, set 10
paper size, set 10

print 25
paper source, set 25

Windows 10
paper type, set

print 25
poster, print 15
print

document 8

fit to page 16
from Macintosh 28
from Windows 8
N-up

Macintosh 29
Windows 14

overlay 18
poster 17
PRN 9
scaling 16
watermark 17

print resolution 25
printer driver, install

Linux 21
printer properties

Linux 25
printer properties, set

Macintosh 28
Windows 9

printer resolution, set
Windows 11

printer software
install

Macintosh 26
Windows 4

uninstall
Macintosh 26
Windows 7

printing
booklets 15
double-sided 16
from Linux 25

R
resolution

printing 25

S
setting

darkness 11
favorites 13
image mode 11
resolution
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Windows 11
toner save 11
true-type option 11

software
install

Macintosh 26
Windows 4

system requirements
Macintosh 26

uninstall
Macintosh 26
Windows 7

status monitor, use 20

T
toner save, set 11

U
uninstall, software

Macintosh 26
Windows 7

uninstalling
MFP driver

Linux 22

W
watermark

create 17
delete 17
edit 17
print 17
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